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Foreword 
Dear customer, thank you for choosing  Q7 phone.  
The phone will give you unprecedented and pleasantly surprised experience: The phone supports dual-GSM card and dual-SIM standby functions. 
The camera of 1.3 million pixel high-definition digital will keep the colorful memories for you. The built-in MP3 and MP4 multimedia player will bring comprehensive enjoyment to you as well.  
Declaration 
The content of this guide is protected by Copyright Law. It is forbidden to copy, distribute, publish or cite the content of this user guide, in whatever form without empowerment of our company. 
The company has carefully and closely reviewed the content of this user guide. Nevertheless, it is possible that there are mistakes and omissions.  
The pictures in this manual only works as the reference, please base on the actual picture while using the phone.  
The company reserves the right to update and improve any products described in this guide, as well as the content of this guide. Amendments will be made without prior notification.  
This is the user guide for the mobile phone only and does not include an introduction to this product’s software and hardware configuration.  
Some functions mentioned in this guide also need the support of a network operator or service provider. If you are unable to confirm whether you will be able to use certain functions or services with this phone, please consult your network operator or service provider. 
The phone may include some commodities, technology or software, which is under the control of export law, and regulations of China or other countries and areas; therefore, any illegal transfer action is forbbiden. 
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In the fullest extent permitted by applicable law, in any case, the company or the party with its permit should take no responsibility for any loss of data, income and any special, occasional or indirect loss, no matter what reason it caused by. 
In order to ensure your safety, please read the “Safety Notice” and “Safety Precaution”. 
Typographic conventions used in this user guide include: 
<>: Shows function key;  
“ ”: Shows prompts on the phone interface;  
【 】:Shows the keys; 

[  ]: Shows the phone menus. 
Safety notice 
Before using the phone, please read and follow below rules carefully. 

 If you dial or answer a call while 
driving, please use the hands-free 
device or use your phone after 
parking the vehicle. 

 Please make sure your phone is switched 
off or in flight mode during the whole flight, 
for mobile phone will interfere with the 
communication network for the airplane. 

 All phones may be susceptible to 
interference, which could affect 
performance. 

 Please switch off your phone near medical 
devices or places which phone using is 
forbbiden. 

 In order to ensure high performance 
and to avoid damage the phone, 
please use the original accessories 
and battery. Please do no use 
products which are not compatible. 

 To avoid the risk of any explosion, please 
switch off the phone at gas stations and 
places near near fuel, chemicals or other 
dangerous substances. 

 To avoid interfering blasting 
operation, please switch off your 
phone in blasting scene or areas with 
sign “Turn off bidirectional radios. Pay 
attention to and obey any relevant 
rules and regulations. 

 Please don’t burn the phone battery or 
treat it as ordinary rubbish as this could 
endanger life and damage the 
environment. Please obey local 
environmental policy, and dispose and 
recycle them timely. 

 If you need to connect your phone to 
other devices, please read the user 
guide of that device carefully for 
safety. 

 Keep small parts (e.g. Storage card) out of 
the reach of children, to prevent them from 
being swallowed or causing other 
dangers. 

 Please back up the important phone 
information or to have a handwritten 
record to avoid important data lost. 

 Make sure the phone is switched on and 
within service coverage before dialing the 
emergency number. Press the call key to 
inform your position. Don’t end the call 
unless told to do so. 
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1. Getting to know your phone 
1.1 Your Phone 

 
1.2 Status icons 

Icon Function description 

  
Represent current SIM1 and SIM2 network signal. The more bars, the 
stronger the signal 

  Flight mode 

 Battery status, more bars indicate more battery capacity left 

  
Unconditional call divert for SIM 1 and SIM 2 

 Unread MMS 

 
MMS memory full 

 
MMS downloading 

 
Headset mode 

 
Unread SMS 

 
SMS memory full 

 
New broadcast 

 
Clock has set 

 
New SP message 

 
PUSH message full 

 Unread PUSH Message 

 
Bluetooth function is activated 

 
Profile has set as Silent Mode 

 
Profile has set as Low ring Mode 

 
Profile has set as Standard Mode 

 
Profile has set as High ring and vibrate Mode 

 
Profile has set as Vibrate Mode 

1.3 Installing SIM card and battery 
(1) Hold on 【End Key】 for about three seconds. 
(2) Slide the battery cover in the direction of the bottom of the phone and then remove it.  
(3) Remove the battery. 
(4) Follow the sign for SIM1 and SIM2 on the phone to install SIM1 and SIM2. Please make sure that the golden contacts of the card face into the phone and the notched corner has the same direction with the card slot, then push the other side of the card gently until it fixes itself in the card slot. 
(5) Replace the battery with its golden contact part facing the set phone battery contact piece, and then replace the battery cover.  

 Caution: 
All function described in this User Manual is based on two SIM cards inserted, please select [Settings�Dual SIM�Standby mode�Dual SIM dual standby]. If only ione SIM card is inserted or the Dual card function doesn’t be activated, then the phone display screen and selecting items might be different with 
what the user manual described.  

1.4 Installing Storage card 
Your phone supports T-Flash storage card. After storage card inserted, you will be able to view or copy the files saved in storage card via your phone, and enlarge the phone memory space. 
(1) Hold on 【End Key】 for about three seconds to switch off the phone. 
(2) Remove the battery cover. 
(3) Follow the arrow direction of "OPEN" on the T-Card slot cover, open card slot cover, put the T-Card into the slot vertically, make sure that the gold contacts of the card face upwards, until the card fixes itself in the card slot. 
(4) Follow the arrow direction of "LOCK" on the T-Card slot cover, pull card slot cover to lock the card slot. 

 Warning: 
1. Don’t forcefully and frequently insert or remove the storage card, in order to avoid damage.  
2. Don’t remove or insert the card while reading or writing the Storage card (such as playing mp3, mp4, taking photo or video, sending or receiving MMS, recording, transmiting Bluetooth files, etc), otherwise, damage might be caused to the phone or Storage card. 

1.5 Battery charging 
Charged by the travel charger 
(5) Install the battery correctly into the phone. 
(6) Insert the lead of the travel charger to connecting slot at the left of the phone, and then connect the charger to a standard power socket. 
Once the charger is plugged, the battery icon  on the top right corner of the screen begins to scroll, showing that it is charging. When the phone has fully charged, the battery icon will stop scrolling, and display as .When charging is complete, unplug the charger from the standard power socket first, and then 
disconnect the phone and charger. 

 Caution� 
1. Please use the approved battery and charger designated for this product, otherwise it may cause an explosion. 
2. If the battery is completely empty, the battery icon will appear after charging for two to three minutes. Generally, the charging time is 2-5 hours, depending on the current status of the phone (whether switched on, during a phone call etc). 
3. Please use charger to charge, try best to avoid charging via USB cable. 
4. For optimal battery performance, charge and discharge the new battery two or three times. The first several times you charge the battery, charge it for at least 10 hours. 

1.6 Power on/ off 
1.6.1 Power on 
Hold on 【End Key】 for three seconds to switch on the phone. 
1.6.2 Power off 
Hold on 【End Key】 for three seconds to switch off the phone. 

 Warning: 
Don’t switch the phone on in areas where wireless phone usage is prohibited or where it may cause interference or danger, and also make sure that you haven’t activated the function “Schedule power on/off”. 

1.7 Using shortcut keys 
Pressing some keys directly from the Home Screen provides direct access to common phone functions. 
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Key Operation Function 

Call key press briefly Enter Call History 

1～2 Keys hold on Enter voicemail box for SIM1 or SIM2 
3～9 Key hold on Enter the corresponding speed dial  

The shortcut functions of Navigation keys are as below: 
While the Home Screen displayed as “Smart style”  

Up/Down Key: Select the profiles icon or  
or the shortcut icons on the Home Screen. 
Left/Right Key: When the shortcut icon is  
selected, Move left/right to choose icon. 

While the Home Screen displayed as “Standard style”  
Up Key: Audio player. 
Down Key: Dual-SIM. 
Left Key: File manager. 
Right Key: Profiles. 

2. Using Call Function 
2.1 Making a call 
2.1.1 Directly call on Home Screen 
(1) On the Home Screen, input the area code and phone number. 
(2) Briefly press 【Call Key 1】 to call from SIM 1 , and briefly press【Call Key 2】to call from SIM 2. 
2.1.2 Make an international call 
(1) Enter the country code (To enter ”+”, just press【* Key】twice). 
(2) Enter the area code (Usually exclude the first “0”) and the phone number. 
(3) Briefly press【Call Key 1】to call from SIM 1 , and briefly press【Call Key 2】to call from SIM2. 
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2.1.3 Call from Contacts 
(1) Enter the contacts to select the desired information. 
(2) Briefly press 【Call Key 1】to call from SIM 1, and press【Call Key 2】to call from SIM2. 
2.1.4 Redial from call history 
 Enter the main menu and select [Call logs], then select your desired number. 
 On the Home Sceen, press 【Call Key 1/2】to check the call history, and selected the desired dialed number. 
Briefly press【Call Key 1】to call from SIM1, and press【Call Key 2】will call from SIM2. 
2.1.5 Dial an extension number 
(1) Enter the switchboard number. 
(2) On the Dialing screen, select <Option→Insert→Pause p>, then enter the extension number. 
(3) Press briefly 【Call Key 1】 to call from SIM1 , and press 【Call Key 2】 for SIM2. The extension number will be transmited in few seconds after getting through the switchboard. 
2.1.6 Make an emergency call 
(1) Enter the emergency phone number. 
(2) Press briefly 【Call Key 1】to call from SIM 1 , and press【Call Key 2】to call from SIM 2. 
2.2 Answering or rejecting a call 
2.2.1 Answer a call 
When there is an incoming call, you can press 【Call Key】or【Left Soft Key】to answer. 

2.2.2 Answer the second call 
If the call waiting function has been activated, when there is new coming call while you’re already on the phone, then you can: 
 Press【Call Key】to answer the second call and the current call will be put on hold. 

 Press 【End Key】to reject the second call and to keep the current call. 
2.2.3 Reject a call 
When there is an incoming call, you can press 【End Key】to reject it. 
2.3 Call options  
While on the phone, select <Menu > and you can have the following options: 
 Turn on handfree: Select to turn on or turn off the speaker function. Press【Right Soft Key】during a call will turn on  the speaker either. 

 Switch: Select [Switch] to hold on the current call, and this function needs network support. 
 Contacts: Select to view your Contacts List. 
 Messages: Enter the Messages screen. 
 Call logs: Enter the Call logs.  
 On: Record the conversation. Select［Menu→Off］to stop recording and the recorded file will be stored via [Multimedia→Recorder→Option→Record file list］automatically. 

 Caution�  
Recording a call is illegal in some countries; therefore, you should get the permission from the person you are calling before recording. 
 

 Mute: Select to turn off the microphone while on the phone so that you can hear the caller but the caller cannot hear you. Select [Unmute] to switch on the microphone again. 
2.4 Adjusting call volume 
During a call, you can press 【Navigation Key】 to adjust the earphone volume. 
2.5 Ending a call 
Press 【End Key】 to end the call. 
3. Call History  
 Enter the main menu, and then select [Call logs] to enter the call list. 
 On the Home Screen, press【Call Key】to view call list. 
3.1 Dialed calls 
Display recent call records. Choose any call record, and select <Option> to access the following operations: 

Option Function 
Details Display the information of the selected call 

Call Make a call by SIM 1 or SIM 2 
Save Save the entry to the SIM card or the phone 
Send message Send an SMS or MMS to the selected entry 
Add to existing contact  Saves the selected number to an existing contact entry (Only 

allow to add it on the phone’s contact list) 
Add to blacklist Set the selected phone number as rejected number, after 

saving ,the number will be available in [Contacts→Blacklist] 
IP call Make an IP call via SIM 1 or SIM 2 
Delete Delete the selected entry from the list 
Delete all Delete all call entries from the list 

For dial function, you may also select [Settings→Dual-SIM→Main SIM settings→Call], and base on your needs to choose SIM1, SIM2 or Prompt to select. 
3.2 Received calls 
Display recent calls received. Similar operations, you may refer to “Dialed Calls”. 
3.3 Missed calls 
Display recent calls unpicked up. For more operations, please refer to “Dialed Calls”. 
3.4 Rejected calls 
Display the phone numbers set as rejected calls. 
3.5 Delete all 
Delete all the call entries. 
3.6 Call timers 
Select the desired SIM Card, and then you can view all relevant information about the SIM Card. 
3.7 Call costs (need the network support) 
 All calls: Record total call charges for SIM1 and SIM2. 
 Max costs: You can set the desired upper limit for call costs. 
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 Cost rate: Record the cost rate for SIM1 and SIM2. 
 Cost reset: Reset the total call charges as zero. 
3.8 GPRS counter 
You can view the detail about GPRS flowrate. 
4. User profiles 
With this function, you can set different user profiles to adapt different environments. There are five preset profiles available; each one has its own default value, which you can set according to your need. 
4.1 Standard 
 Activate: Activate the chosen profile. 
 Settings: Set the following options as required. 

 Ring settings: Set the call ring or msg ring for SIM1 and SIM2. 
 Adjust volume: Adjust volume for incoming ring tone, message ring tone, etc. Press【Navigation Key】 to ajust the volume. 
 Call alert: Set the desired call alert mode for SIM1 and SIM2. 
 Message alert: Set the desired message alert mode for SIM1 and SIM2. 
 Alarm remind: Set the desired alarm reminding mode 
 Key tone: Set the desired keypad tones. 
 Battery low alert: Set whether to activate the battery low alert tone. 
 Power on/off tone: Set whether to activate the power on/off tone. 
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 Rename: Modify the name of the selected profile. 
4.2 Vibrate  
For the settings, please refer to”General”. 
4.3 High ring and vibrate 
For the settings, please refer to” General”. 
4.4 Low ring 
For the settings, please refer to” General”. 
4.5 Silent 
For the settings, please refer to”General”. 
5. Contac
The phone is designed with high capacity memory space. Different SIM card will have different memory capacity. 
5.1 View a contact 
Enter the contacts, the phone is defaulted to show contact list with all entries. Press【Left Key/Right Key】to switch between different groups. 
The marshalling sequences are as following: No name, special symbol, number, and letter (Chinese names will be ranked after its first phonetic letter). 
5.2 Smart search 
Enter the main menu, and select [Contacts] to view the contacts list. 
You can search the desired contact by pressing the corresponding keys (The phone supports fuzzy search). 
  For example：Search “sam” 

Input the numeric keys ”726” which is corresponding to the English letter”s”, ”a” and “m”，then you can find it. 
  For example：Search name saved beginning with symbols 
Directly input “1” to find it. 
Select the desired contact, and then choose <Option> to access the following operations: 

Option Function 
New Add a new contact 
Search Search the details of the desired contact number 
Write message Allow you to send an SMS, MMS to the selected contact. 
Dial Make a call to the selected contact 
Send vCard Allow you to send the selected contact via SMS or Bluetooth 
Delete Delete the selected contact 
Mark Mark the selected contact or all contacts 

Copy Copy the selected contact to SIM1, SIM2, the phone or the 
memory card 

Speed dial 
settings 

Preset the speed dail numbers.  On the Home Screen, hold on 
3~9 keys will directly dial the number corresponding to that key. 

Caller ID Set the selected number as the phone number. The function and 
the quantity of the saved numbers all depend on the SIM card. 

Memorystatu
s View the contacts memory status of the SIM1,SIM2 or the phone Others 

Single line 
display/Doubl
e line dispaly 

Select to display the contacts by single line or double line. 

5.3 Adding a new contact 
On the Contacts list, select<Option→New>to create a new contact. 

 Phone: You can input the contact name, mobile number, home number, etc. You can also set special image and ring for the contact entry 
 SIM1: The input record will be saved to SIM1, with each name one phone number.  
 SIM2: The input record will be saved to SIM2, with each name one phone number. 

 Caution� 
While creating a new contact, the name can be blank; however, the phone number can not. 

6. Message
The messaging service is a kind of network service. Whether it can work normally depends on your SIM card and the services supplied by the network operator. Therefore, please confirm with your network operator first before using this function.  
6.1 Write message 
You must obtain the corresponding service center number from the network operator before using this function. The memory capacity differs due to different types of SIM Card. 
6.1.1 New SMS 
The phone supports multiple SMS editing. 
On the Home Screen, press【Left Soft Key】and select [Message→Write message→New SMS] to edit a new SMS directly. 
After writing an SMS, click <Option> to have the following operations: 
 Send: Send the message to the desired recipient, or you can click <Contacts> to search your desired contact, and then send it after chosing SIM card. 
 Insert template: Select the desired template and insert it into the SMS. 
 Add Contact info: Retrieve the desired contact info (eg.name and phone number) from the contacts and add to the SMS. 
 Add phiz: Add the desired phiz and insert it into the SMS. 
 Save: Save the edited SMS into the draftbox. 
6.1.2 New MMS 
MMS is a multimedia message, supporting pictures in GIF, JPEG, WBMP, and BMP format. 

Caution� 
The MMS can only be used when it is supported by the network operator; and only phones with multimedia function can receive and normally display it. 

On the Home Screen, press【Left Soft Key】and select [Message→Write message→New MMS] to create a new MMS. 
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 Send: Send the edited MMS to the desired recipient. You should preset the recipient’s number before sending. 
 Recipients: Add the recipient number by selecting [Add recipient] or [Add group]. 
 Cc: The MMS can be carbon copied to the desired recipient. 
 Bcc: Neither recipient nor carbon copy recipient can see each other’s phone number. 
 Subject: Edit the MMS title. 
 Edit content: Edit the MMS content, click <Option> to access the below operations: 

 Text: Edit the MMS text. 
 Add 

Slide: You can insert a new slide. 
Picture:：Select the desired picture and insert into the MMS. The phone supports WBMP, BMP, GIF, and JPEG formats. 
Audio：Select the desired audio file and insert into the MMS. The phone supports MIDI, WAV, MP3 and AMR format. 
Video: Select the desired video file and insert into the MMS. The phone supports 3GP and MP4 formats. 

 Delete 
This slide: Delete the current slide. 

Picture: Delete the picture in the current slide (This option will be available after a picture is inserted). 
Audio: Delete the audio file in the current slide (This option will be available after an audio file is inserted). 
Video: Delete the video file in the current slide (This option will be available after a video file is inserted). 

 Previous slide: Move to last slide (This option will be available when there are several slides). 
 Next slide: Move to the next slide (This option will be available when there are several slides). 
 Set slide time: Set the playing time for the current slide, and the valid period is 1-600 seconds. 

 Preview: Preview the slide in sequence. 
 Save: Save the current MMS to [Drafts], available for re-editing and sending out. 
6.2 Inbox 
Store all received SMS and MMS.  
6.3 Outbox 
Store all SMS and MMS failed to be sent. 
6.4 Drafts 
Save edited SMS and MMS havn’t sent. 
6.5 Sentbox 
Store all the SMS and MMS successfully sent out. If you want the sent messages be saved automatically, please select 
[Messages→Option], then select [SMS settings→Save sent messages→Save]. 
6.6 Message setting 
On the Home Screen, press【Left Soft Key】to enter the main menu, then select [Message→Option] to enter the message setting menu. 
6.6.1 Templates 
While editing messages, you can directly cite the preset common phrases. Select <Edit> to set the common phrases by yourselves (Maximum: 5 pieces). 
6.6.2 Voice mail server 
This function works like an answering machine, which can transfer a missed call to your personal voice mail, allowing the caller to leave a voice message and notify you by an SMS. Voice Mail is a part of the bundled software provided by network operator, therefore, you need to register to active this function, and 
manually set the phone. Please contact with your network operator for more details. 

 Caution：  
It’s workable to transfer the voice call into the voice mail (The number the call will leave a message) by setting “Divert calls”.  

6.6.3 Broadcast message 
You can receive broadcast text messages with various contents via network service, such as news, weather or traffic information. For more details, please consult your network operator. 
 Read: Read the broadcast message received. 
 Broadcast launch: If select [Off], then no matter corresponding channel number has been set or not, the phone can’t receive any broadcast messages. 
 Channel settings: You can select [Add channel] or [Channels]. 
 Languages: Multi-languages available, you can listen to the broadcat in your desired language. 
6.6.4 SMS settings 
 SIM1 msg center: While sending messages, you must set the service center number provided by network operator. Most SIM cards defaulted contain the service center number. You can also gain this number directly from the network operator.  

 Caution: 
If you modify or delete the service center number, an SMS might not be sent successfully. 

 SIM2 msg center: Please refer to [SIM1 msg center]. 
 Message validity period: Allows you to set the length of time during which your SMS will be stored in the message center. The validity period depends on the network operator. 
 Status report: Select [On], then the text message center will inform you when you successfully sent a message. 
 Save sent messages: You can select whether to save the sent message or not. 
 Preferred storage: You can select to save the SMS to the SIM card or the phone first. 
6.6.5 MMS settings 
 SIM1 MMS count/SIM2 MMS count: You can select SIM1 MMS acount or SIM2 MMS acount 
 Delivery report: Select [Activate], then the MMS center will inform you that the recipient has received and downloaded the MMS.  
 Send read report: Click [Activate], then you will receive a report message when the sent MMS has been read by the recipients. 
 Anonymous send: Select [Activate], the MMS will be sent to the desired recipient without displaying the sender’s phone number. 
 Priority: Set the priority level for MMS. 
 Receive MMS: You can select [Manual receive] between [Auto receive]. If manual retrieve function is activated, then you have to manually download the received MMS from the inbox; if auto function is chosen, then the phone will automatically download the received MMS once the phone is back to the Home 

Screen. 
 Play audio: After activated, the phone will play sound while reading a MMS. 
 Allow adversting: After activated, the phone will receive advertisement while receiving a MMS. 
 Validity period: You can set the validity for the MMS. The period depends on the service provided by network operator.  
 Storage: You can select the desired storage location for pictures, music or video files of MMS. 
 Restore default: Reset to the default setting. 
6.6.6 Message capacity 
You can view memory capacity status for SMS and MMS via this function. 
7. Internet  
The network service allows you to access the Internet via wireless communication, from which you can gain rich information & resources, and E-commerce from the Internet.  
On the Home screen, press【Left Soft Key】and select [Internet]. 

 Caution� 
1�Your network service provider may not support some functions. In order to ensure the browser work normally, please confirm first that your SIM card supports and have the Internet function activated. 
2. If you browse the web page, flowrate fee will be charged. 
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7.1 Input URL 
Enter the wanted website, and click <Confirm> to connect it. 
7.2 Homepage 
By selecting this option, your mobile phone will directly visit the preset or defaulted homepage. 
While browsing the website, press【Left Soft Key】 to swtich between address bar, websites and tool bar. 
The use of tool bar: 
While viewing the web, below icons will function as per below: 

Icon Function 

 
Homepage: Return to Homepage. 

 Refurbish: Refurbish current webpage. 

 Close: Close current webpage. 

 Back: Based on the history, back to visit last viewed webpage. 

 Forward: Based on the history, forward to visit next webpage. 

 Bookmark: Save current URL address into the Favorites 

 History: View the history. 

 Save files: Save the snapshot, images or music files. 

 
Quit: Select whether to quit the browser. 

 
7.3 Bookmark 
Bookmarks are defaulted as blank, and you are able to edit it as you want. Save the common visited website into the Favorites, and marked by simple names. Select one saved name, then the corresponding web will be connected. Please refer to below setting: 
 Add bookmark: Enter the new bookmark address and name, then select <OK> to save it. 
7.4 History 
Record the websites you visited before. 
7.5 Offline 
After saving a website as snapshot, you can browse the website while offline. 
7.6 WAP settings 
7.6.1 Browser settings 
 Clear cache: In order to avoid congestion and improve the web browsing speedn, please clear the cache regularly.  
 SIM1 network account: Set the SIM1 network port. 
 SIM2 network account: Set the SIM2 network port. 
 Download image: After enabling this function, the image will only be displayed after being downloaded. 
 Play background sound: After enabling this function, you can play background music. 

 Accept push: If enabling this function, you can receive Push messages.  When receiving push message, an icon  will appear on the Home Screen, and you can view the Wap push message sent by system via this menu. 

��  Caution: 
Do not arbitrarily change the settings, or you may not normally visit the website. 

7.6.2 Network account 
You can select the desired nekwork account: China Mobile GPRS, China Mobile MMS or China Unicom WAP, and you can add the desired account by yourself as well. 
On the Network count screen, select <Option> to process following operations: 
 New connection 

 Securty: Set whether to enable the security functi on. 
 User name: Edit the network user name. 
 Password: Set the connect password. 
 APN: Set the network access port name. 
 Gateway IP address: Set the network IP address. 
 Gateway port: Set the network port. 
 Rename: Edit the network account name. 
 Set as homepage: Set the homepage website address. 
 Advanced settings: Set the DNS address and network type. 

 Add from list: You can add many defaulted network accounts. 
 Search: Search for the network configuration registered in the nearby areas, which can be directly used after being searched. 
 Delete: Delete the selected network account. 
 Edit: Edit the selected network account. 
7.6.3 Preferred storage 
You can choose the place where to save the pictures, music or video files from the Internet. 
7.6.4 GPRS setting 
You can select to always open GPRS or open it when required. 
7.6.5 Restore default 
Reset the WAP settings back to the factory set. 
8. Multimedia
8.1 Camera 
Enter the main menu, and select [Camera] to enter the camera preview screen. 
8.1.1 Capture a photo 
On the Capture Preview screen, press 【OK Key】to take a photo. 
Capture setting 
On the Capture Preview screen, select <Option> to process below operations. 
 Self Capture Mode: Albe to activate self-capture mode or not. 
 Photos: Enter Image Vierwer to view photos captured. 
 Camera settings 

 Flash: Set the flash. 

   : On 

: Auto 

: Off 
 Contrast: Set the contrast grade. 
 Anti-flicker: 50Hz and 60Hz are available for you to choose. 
 Delay timer: After seting the delayed time, press 【OK Key】while taking photos, the Preview screen will display a countdown screen, and automatically take a photo when time is up. 

: Off 

: 3 sec 
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: 10 sec 
 Cont.shot: Set to continuously shot pictures. 

: Off 

: 3 shot 

: 6 shot 
 Image settings 

 Image size: Available to set the resolution. 

   : 640 X 480 

: 220 X 176 

: 320 X 240 
 Image quality: You may select as you need. 

   : Normal 

: High 

: Low 
 White balance: White balance settings. 

: Auto 

: Sun light 

: Fluorescent 

: Cloudy 

: Incandescence 
 Scene mode: Available to switch between Nomal mode and Night mode. 

: Normal 

: Night 
 Storage: Select the storage location for the photos captured. 
8.2 Video recorder 
Enter the main menu, and select [Video recorder] to enter the video preview screen, and press �OK Key�to start recording the video. 
Video record setting 
On the Video Preview screen, select <Option> to process below operations. 
 Self Capture Mode: Albe to activate self-capture mode or not. 
 Video viewer: To view the shot video. 
 Camcorder settings 

 Night mode: Select to activate night mode or not. 
 Anti-flicker: 50Hz and 60Hz are available for you to choose. 
 Type: You can set the video format as AVI or 3GP, as you need. 

 Storage: Select the storage location for the photos captured. 
8.3 Mobile TV 
On Home Screen, pull the antenna, press  �Left Soft Key�to enter the main menu, and select [Mobile TV] to enter the TV function. The phone will automatically select the TV channel when the TV function is used for the very first time. 
 Press 【Left/Right Key】 to switch between last or next channel 

 Press【Up/Down Key】to adjust the volume 
 Press【OK Key】to display on full screen 
8.4 Audio player 
The phone can play music saved in the phone or storage card and the download ring, and also supports MP3 background playing.  

 Notice� 
MP3 supports MPEG 1 layer 3 audio, MPEG 2 layer 3 low sampling rate extension and MPEG 2.5 layer 3 (unofficial). 

On Home Screen, press 【Left Soft Key】 to enter the Main menu, and select [Audio player] to enter the Audio Player screen: 
The below table shows the icons on the Player screen: 

Icon Description 

 Press【Up Key】to display or pause 

 Press 【Down Key】to stop  

/  Press【Left/Right Key】to skip to last /next one 

 
Show the playing volume, press【+ Key】/【- Key】to turn up/down the 
volume 

8.4.1 Background audio player 
While playing a song, press 【End Key】to quit the Playing screen to enter the background playing mode. 
8.5 Video player 
The video player supports the video file in 3gp, mp4 or avi format. 
If the file is in unsupported standard format, please use conversion tool to converse it into a supported standard format. 
Enter the Main menu, and click [Multimedia→Video player]. 
Icon description: 

Icon Description 

/  
Play or pause  

/  Skip to the last/next file 

 Stop playing 

 Turn up or down the volume. Press【+Key】or 【- Key】to adjust the volume. 
8.6 Image browser 
The function provides a prompt access to view the photos and pictures. 
On Image Viewer Screen, select <Option> to process following operations: 
 Change folder: Automatically search all channels and save into the radio list. 
 Send: Send the selected picture via MMS or Bluetooth. 
 Slide play: Display pictures in the mode of slide on the full screen. 
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 Delete: Delete the selected picture. 
 Set image as wallpaper: Set the selected picture as wallpaper for the phone. 
 Rename: Rename the selected picture. 
 Mark: Able to mark selected picture. 
 Details: Show the details for the selected picture. 
 Slide settings: Able to change the slide display effect via setting [Select effect] and [Delay time]. 
8.7 Recorder 
On Home Screen, press 【Left Soft Key】 to enter the main menu, select [Multimedia→Recorder], and choose <Option→Start recording> to start recording. Select <Pause> to have the recording pause for a while, select <Stop> to cease recording. After ceasing the recording, the recorded file will be automatically 

save in the folder [Audio], press 【Up/Down Key】to select  or select <Option→Record file list> to check. 
While complete the recording, select <Option> to process following operation: 
 Audition: Play the recorded file. 
 Record again: Record a new file. 
 Delete: Delete the selected record. 
 Send: Send the selected record via MMS or Bluetooth. 
 Record file list: Check all recorded files. 
8.9 File manager 
This menu allows you to manage files stored in the USB disk or storage card.  
 Audio: Save the audio files, such as wav, MP3, midi, amr, acc, etc. 
 Ebook: Save Ebook files. 
 Photos: Save the captured photos and image files, supporting formats including: jpg, gif, bmp, and wbmp.  
 Video: Save the captured video files, supporting avi, mp4 and 3gp formats. 
 vCard: Save the vcf file. Copy a selected contact from contacts to the memory card, and then save in vcf format in this folder. 
9. Tools
9.1 Alarm  
On the Home Screen, press【Left Soft Key】 to enter the main menu, and select [Tools→Alarm], then you can set the alarm name, time, ring and mode. 
There are three alarms available, which can be activated simultaneously. Every alarm has three prompt modes, [Once], [Every] or [Weekly]. 
9.2 Calendar 
On the Home Screen, press【Left Soft Key】 to enter the main menu, and select [Tools→Calendar] to enter the Calendar screen.  
Select <Options> to enter the following options: 
 Add task: Create a new schedule and the schedule is defaulted as current date. 
 View tasks: View whether there is a schedule on the date clicked. 
 All tasks：View all the schedules. 

 Clear tasks today: Clear the schedule on the chosen date. 
 Clear all: Clear all the schedules. 
 Go to date: Input the preferred date and Press 【OK Key】 to view the schedule set for the chosen date. 
9.3 Calculator 
Directly input numbers, press【Navigation Key】 to select your desired operation symbols (+, -, /, X). Press 【OK Key】 to get the answer. Press 【Right Soft Key】 to clear last digit entered , while holding on the key to clear all digits. 
9.4 Bluetooth 
 Open/Close bluetooth: This function allows you to switch the Bluetooth on or off. 
 Bluetooth visibility: Set to show or hide the Bluetooth of your phone. If you select to hide the phone, other devices cannot detect the Bluetooth device of your phone, even you activated your Bluetooth function.   
 Paired device: You can search for the nearby Bluetooth-enabled devices  
 My Bluetooth name: If Bluetooth function activated, while other devices search for Bluetooth signal, the corresponding name represents your phone. 
 Storage: Able to set the storage location for files received via Bluetooth. 
 Help: Provide relevant Bluetooth helping information. 
9.5 E-Book reader 
You can view file in TXT format by Ebook and copy the TXT file to the [Ebook] folder in the memory card from your PC. 
On the Home Screen, press【Left Soft Key】to enter the main menu and select [Tools→E-Book reader] to enter the Ebook screen you read last time. Select <Back> to enter the Ebook list and reselect the desired file to read. 
On the Ebook screen, select <Option> to access the following options: 
 Add bookmark: Add the content of the current page to bookmark. 
 View bookmark: View the content of bookmark that has been added. 
 Jump to first page: Jump to first page of the current Ebook and read it. 
 Jump to last page：Jump to last page of the current Ebook and read it. 
 Jump to:Input the pages which you want to jump and press <Confirm> to turn to it. 
 Cancel backlight always on/ Backlight always on： Select to turn on or turn off the backlight function. 

 Caution: 
If the memory space is insufficient, there will be a notice shown on the Ebook screen. Please delete needless file to ensure at least 500KB space left for the memory card. 

In Ebook folder, select the desired Ebook and press <Option> to process following operations: 
 Detail: View the details of the select Ebook, like name, date, time, etc. 
 Recent books: View the Ebooks read recently. 
 Send via blutooth: Send the selected Ebook to others via blutooth. 
 Delete: Delete the selected Ebook. 
 Mark: Able to mark the Ebook. Marked Ebook can be sent or delected, etc. 
 Settings: You can set browse page method and the color. 
10. Settings
10.1 Dual-SIM  
 Set dual SIM call divert 
You can set the two SIM cards to forward the calls to each other. Before using this function, please select [Settings→Dual-SIM→Dual SIM settings］ 

 Standby mode: You can select the standby mode for SIM card, either to have one SIM card standby, or to have both SIM cards standby simultaneously. 
 Main SIM settings: There are several types as per below: 

 Communication: For functions like call, SMS, MMS, and Internet, you may choose SIM card type to be used according to your need, and you may also choose to have prompt choice while using some certain functions. 
 Speed dial: If enabling this function, you can speed dial the phone number via the preset SIM card. 
 Reply by original SIM: You can activate the function to reply from current SIM card for phonecall, SMS, MMS and Network service. 

 Caution: 
“Reply from current card” has precedence over “Master and Additional card setting”. 
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 Set SIM name: You can name the Card as you want. 
 Dual SIM settings: Please follow the prompting steps shown on the screen to process dual-SIM setting. 
 Help: Provide helping information. 
10.2 Call setup 
10.2.1 Network selection 
 Auto select: The phone can automatically search and register available networks. 
 Manual select: Enable this function, the phone will search for the network, and list all searched networks, then you need to choose the one needed to register. 
10.2.2 Call divert  
Based the set diverting conditions, incoming calls will be forwared into voice mail or other numbers. 
 Unconditional transfer: All incoming calls will be transferred to the preset number or your voice mail. Select［Query status］to view the current unconditional call divert status. 
 Divert if busy: Calls will be transferred to the voice mail or the preset phone number when you are on the phone.  
 Divert if no answer options: Calls will be transferred to the voice mail or the preset phone number, if the set time is over and phone still won’t be answered. 
 Divert if unreachable: Calls will be transferred to the appointed number or your voice mail, when your phone is out of the service coverage or is switched off. 
 Cancel all diverts: All Call Divert functions are cancelled. 
10.2.3 Call barring 
This function helps you to restrict the incoming and outgoing calls.  
Select the desired call and press <Confirm>, then you can select [Activated], [Off] or [Query status]. Select [Activated], the phone will need network support currect setting. Below are the available restricted call selections. 

Option Description 
All outgoing calls Restrict all outgoing calls 
All incoming calls Restrict all incoming calls 
Incoming calls when roaming No incoming calls while roaming 
International calling Outgoing international calls forbidden 
Dial when INTL roaming Incoming international roaming forbidden 
Cancel all barring Cancel all call restrictions 
Change password Change the password for Call Restrict function 

 Cautioin� 
1� Some network operators forbid the function. For more details, please contact your network service provider. 
2. The network operator will provide you the initial network password while you apply for this service. 

10.2.4 Call waiting (Need network support) 
 Activate: If you set the function on, the network will alert you that there is an incoming call. You can keep current call and answer another one. 
 Off: Cancel call waiting function, then the new incoming calls won’t be answered while you’re on the phone already. 
 Query status: Select it to view current status of this function. 
10.2.5 Hide ID (Need network support) 
 Hide ID: While calling, the recipient won’t see your phone number.  
 Display own ID: While calling, your phone number will be visible for the recipient. 
 Display ID by network: While calling, whether your phone number will be visible or not for the receiver depends on the network presetting. 
10.2.6 Select line 
You can choose line 1 or line 2 as you need. 
10.2.7 Flight mode 
 Activate: Activate flight mode, then all network service won’t be available. 
 Select when power on: You can select whether to activate flight mode when power on. 
10.2.8 Others 
 IP shortcut key 
After activating this function, selecting <Option→IP Call>, then preset IP number will be automatically added before the number you want to dial and call via it. 
 50 secs warning 
If you activate the function, an elapsed time reminder will be heard at the 50th second of every minute during your call, so that you may end the call timely to save the phone fare.  
 Connect prompt 
The phone will vibrate to prompt you when the recipient answers your phone. 
 Answer /Reject mode 

 Reply SMS after reject: You can select whether to reply an SMS after rejecting a call. 
 Any-key answer:You can answer calls by pressing any key(except【Left Soft Key】and【End Key】. 

 Auto redial 
If you set this function on, the phone will redial the number after an unsuccessful call, 
10.3 Phone setup 
10.3.1 Time and date 
 Set time: Directly input the time or press 【Up /Down Key】to set it. 
 Set date: Directly input the date or press 【Up /Down Key】to set it.. 

 Time format: Set the time format as [12 hours] or [24 hours]. 
 Date display type: Set the date format as [Year-mon-day], [Mon-day-year] or [Date-mon-year]。 
10.3.2 Select language 
Two languages are available, [English] and [Simplified Chinese]. 
10.3.3 Auto power on/off 
You can set the phone to switch on/off at a scheduled time. For the setting method, please refer to “Alarm”.   
10.3.4 Motion Sensor Switch 
The function allows you to activate the sceen auto-rotating function for idle wallpaper, audio player.The function is defaulted as “Deactivated”.  

 Notice� 
Motion sensor only works when screen backlight functions. If the backlight is off, then the motion sensor will be deactivated and there won’t be any responses. 

 Idle wallpaper: Click [Idle wallpaper], then process “Accelerating shaking from right to left”, therefore the wallpaper will be switched as last defaulted one on the list; process “Accelerating shaking from left to right”, then the wallpaper will be switched as the next defauled one on the list.  

 Notice: 
Current wallpaper switching function only supports the defaulted wallpaper. For customized paper, it won’t work. 
 

 Audio player: Click [Audio player], process “Accelerating shaking from right to left”, therefore the song will be skipped to last defaulted one on the playlist; process “Accelerating shaking from left to right”, then the song will be switched as the next defauled one on the playlist. 

 Caution: 
Song skiping won’t work while background playing is on.  

10.3.5 Shortcut settings 
 While the Home Screen is smart style, you can change the shortcuts on Home Screen via this.  
 While the Home Screen is common style, you can change the responsible shortcuts for 【Navigation Key】under standby mode. 
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10.3.6 Power management 
Display the battery capacity. 
10.4 Display settings 
10.4.1 Wallpaper settings 
Select the default or other pictures as the wallpaper of the phone. 
10.4.2 Idle screen style 
”Standard style” and “Smart style” are available. 
10.4.3 Power on display  
You can select the preset animation or others as the Power on animation for your phone.  
10.4.4 Power off display  
You can select the preset animation or others as the Power off animation for your phone.  
10.4.5 Contrast 
Press 【Left /Right Key】to adjust the contrast. 
10.4.6 Backlight 
Select the desired backlight time. 
10.4.7 Keypad light 
Select the desired keypad light time. 
10.5 Security settings 
In order to secure the information, you can set PIN code, PIN2 code, power-on password and Guardlock function. 
10.5.1 PIN 
PIN code is the personal identification number for SIM card. If never be modified, the initial password set by network operator should be 1234 or 0000. If activated the power-on PIN code, then you have to input the PIN password each time you switch the phone on. You can modify the PIN code to prevent your SIM 
card being used by others.  

Caution� 
If you input your PIN code incorrectly three times in succession, the SIM card will be locked automatically, and prompting to enter PUK code to unlock it. Therefore, please do remember the PIN code, if you modify it. 

PUK code (PUK1) is made up by 8 digits, unmodifiable. When the phone is locked by PIN code, please enter correct PUK code to unlock the phone. If you incorrectly input the PUK code ten times in succession, then the SIM card cannot be used any more. Some PUK codes are provided together with the SIM card, 
some should be gained from the network service provider. If you don’t know the PUK code while your PIN code is locked, please never input the code casually. In this case, please call the hotline of the service provider for your SIM card, after simply checking about the user identity, you can gain the PUK code for free 
to unlock your phone. 

 Caution� 
Please be careful when use this function. If you forget PUK code, please consult your network operator. If you incorrectly input the PUK code ten times in succession, the SIM card will be scrap.  

Select the desired SIM type and have the following options: 
 Activated: You should input PIN code each time switching the phone on. 
 Modify: You should activate PIN code before modifying it. 
 Off: You should input the correct PIN code before deactivating it. 
10.5.2 PIN2 
PIN2 code is the personal identification code required for some certain functions (such as set fixed number, set phone fare, etc). 
PIN2 code is another password provided together with SIM card by service provider. If wrongly input it for three times in succession, the phone will be locked untill correct PUK2 code entered, for detailed operation, please refer to PIN code and PUK code.  

Caution� 
If you incorrectly input the PUK2 code ten times in succession, you will not be able to use SIM card. Please be careful when use this function. 

10.5.3 Privacy 
Secured by phone password, the phone will be protected from other unotherised users. When password function has been activated for call history or messages, you have to enter correct password on corresponding main menu or sub-menu. The defaulted password is “1234”.  
10.5.4 Auto keypad lock 
After activating this function, the phone will be locked automatically if the time you set is arrived, so as to avoid error operations. 
 Manual lock keypad: On the Home screen, press【* Key】and select <Lock> to lock the keypad manually. 
 Manual unlock keypad: On the Home screen, select <Unlock> and press【#Key】to unlock the keypad manually. 
10.5.5 Lock screen by end-key 
Once activated this function, when the backlight is on, press【End Key】to turn off the backlight and auto lock the keypad. 
10.5.6 Power-on password 
You should set the power on password when you use this function for the first time (The password is 4-8 digits). After activated this function, you shoud input password each time you switch the phone on. 

 Caution: 
Power on PWD doesn’t have the limitation for wrongly inputting. Please remember carefully about the Power on PWD, otherwise, the phone won’t be switched on normally once password forgotten.  

10.5.7 Guardlock 
Guardlock (MSD) is nicknamed as Mobile Phone Dog. When others illegally use your phone, information like CELLID of the phone will be collected and sent to preset mobile phone; moreover, the function will prevent others to use the phone after certain times or certaim power-on times. 
This function is defaulted to be off. To activate it, please modify the password. Then you need to enter the password if you want to activate, deactivate, or modify the password to process operation, and the password has 6 digits. To activate it, you have to enter a preset mobile phone number (The mobile phone 
number set to receive the message if the phone is stolen) apart from the password. 
After activated, the phone stores the IMSI number for original SIM card, which is sole and unique, if you insert another SIM card, there will be a prompt, asking you to input the guardlock password. If you wrongly enter the password for three times in succession, the phone will default it as illegal and display a relevant 
prompt, then collect and send information like CELLID, LAC, MCC, MNC, MCN to preset mobile phone number. While receiving this message, legal user can report it to the police, who can inquire the illegal usage situation (Including the used location, call history, etc) from network operator via the piece of 
information. 
The message will be kept senting to the preset mobile phone till it is successfully received. If the stolen phone is on over 24 hours or re-switch on, the phone will resend a message to your preset phone number. When the message has been successfully sent up to 15 times, any illegally used SIM card won’t work in 
the stolen phone, whick will automatically switched off. 

 Caution: 
Please report to the police timely if the phone is stolen, but this doesn’t mean that the lost phone will be definately traced back. Therefore, please take care of your personal property.  

If the phone defaults the SIM card inserted is illegal, then guardlock function can not be activated, and relevant setting can not work. If another SIM card is inserted, enter correct password, message count will be sent from zero, meanwhile, there will be a prompt, asking you whether to bind this SIM card. Select 
binding, then the phone will renew the IMSI number and default the SIM card as the designated one. 
 Activated: Before activating this function, please set the password first, if password hasn’t been set, the phone will hint “Change password first”, then please enter [Change password] to finish the password setting and back to activate this function. While activating it, guardlock password and notified mobile 

phone number (The number to receive the information of the SIM card illegally used in the stolen phone) are required. After these, guardlock function will work.   
 Off: To deactivate guardlock function, you should input correct Guardlock password. 
 Change password: Modify guardlock password. 

 Warning: 
Please use this function carefully. The phone won’t be used if password forgotten.  

10.6 Restore settings 
Reset all parameter values into default status. Please enter the privacy preserving password (Initial password is 1234) to resume factory setting. 
11. Phone Maintenance
Mobile phones arep precision electronic devices and must be carefully maintained. The following advice can help you to look after your phone and prolong its life. 
 The phone and its spare parts should be put out of the reach of children. 
 Keep the phone dry. Rain, moisture or water will corrupt its electronic circuitry. If your phone does get wet, remove the battery immediately and take the phone to the nearest local authorized service center. 
 Don’t put the phone in dusty places or this will affect the daily use. 
 LCD is a part of the phone which could be easily damaged, so try to avoid dropping the phone on the ground or any other forms of shaking. Do not touch the screen with a sharp object. 
 Don’t put the phone in a high temperature environment. High temperatures will shorten the life of electronic devices, destroy the battery and desort or melt a phone’s plastic shell. 
 Don’t put the phone in a low temperature environment. Otherwise, when the temperature rises to normal temperature, there will be moisture in the phone and this will destroy the phone’s electronic circuitry. 
 Don’t throw, knock or shake the phone intensely as this could damage the electronic circuitry and structure of the phone. 
 Do not use rough chemical or abrasive cleaners to clean the phone as these could damage the phone. 
 Don’t paint your phone, in case that detachable parts will be pasted and affect its normal use. 
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 Please use a clean, soft mull to clean lens, such as camera lens, etc. 
 If you have to replace the phone’s antenna, please only replace it with accessory or designated one. To use unauthenrized antenna or spare parts will damage the phone and disobey relevant regulations for wireless device. 
12. Troubleshooting 
If you encounter usage problem, please refer to below troubleshooting guide. If relevant solution isn’t available in this User Manual, please contact authenrized maintenance centres. 
12.1 The phone can’t be switched on 

Possible reason Solution 
You haven’t hold on the Power Key  long 
enough 

Press and hold on the key over 2 seconds. 

The battery power is used up Charge the battery 
Incorrect battery installation Install battery correctly 
Illegal use causes the phone can’t be 
switched on 

Please enter the correct security password 
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12.2 The phone is switched off automatically 
Possible reason Solution 

Activate the Auto Power Off function Please cancel it if you don’t need. 
The battery power is used up Charge the battery 
Battery loose Install the battery correctly according to the User 

Manual. 

Illegal use leads to auto power off. Please enter the correct security password 
12.3 PIN/ PUK code lock 

Possible reason Solution 
Enter wrong 
PIN Code ( Personal Identification Code) or 
PUK Code (Personal Unlocking Key) 

Enter correct password 

 Caution� 
1. If you enter incorrect PIN code for three times in succession, many functions for SIM card and phone will be locked. For more details, please refer to “10.5 Security” on page 18 . 
2. If you do not know the correct PIN code and PUK code, please contact your operator or network service provider. 

12.4 Bad call quality 
Possible reason Solution 

The signal changes suddenly Maybe you are moving at high-speed (e.g. on a train 
or bus). Observe the signal strength and select the 
place with the strongest signal to make a call and 
ensure better call quality. 

The area does not have a good 
signal 

Please move to open area. 

12.5 Can’t answer a call 
Possible reason Solution 

The call forwarding option has been 
set  

Please cancel call forwarding according to 
requirements. 

The call barring option has been set Please cancel the function of incoming call barring or 
roam incoming call barring. 

12.6 Can’t make a call 
Possible reason Solution 

You are out of network service 
coverage 

Please check if the network is in normal status. 

The SIM card has been 
incorrectly inserted 

Please check whether your SIM card can be used normally. 

The keypad locks 
automatically 

Press the 【Left Soft Key】and then press 【# Key】 to 
unlock your keypad. 

Call barring has been set Please cancel the call barring option according to your 
requirements. 

12.7 The call volume is too low 
Possible reason Solution 

The call volume has been set too low Please turn up the call volume. 
12.8 The recipient cannot hear your voice 

Possible reason Solution 
The microphone is too far from the 
sound source 

Please put the phone’s microphone closer to your 
mouth. 

12.9 The incoming call doesn’t ring 
Possible reason Solution 

The phone selects silent mode Please reset the ring type into high ring or hight right 
and vibrate. 

The ring volume is set too low Please turn up the volume 
The call forwarding option has 
been set 

Please cancel call forwarding according to 
requirements. 

12.10 The battery can’t be charged 
Possible reason Solution 

The battery is worn out and the 
charging time takes too long 

Please charge when the phone prompts low battery. 

The battery doesn’t connect well to 
the phone 

Please ensure the battery has been inserted correctly. 

The charger doesn’t connect to the 
phone 

Please ensure that the interface between the charger 
and the phone is correctly connected, and the charger 
icon should appear on the screen. 

Battery or charger has been 
damaged 

Please contact one of our maintenance centres. 

The surrounding temperature is too 
low or too high 

Please make sure the phone is charged in a normal 
temperature. 

12.11 Can’t display network 
Possible reason Solution 

The SIM card has been 
incorrectly installed  

Please refer to the SIM card installation method. 

The contact between the SIM 
card and phone is dirty 

Please ensure the contact between the SIM card and 
phone remains clean. 

The SIM card does not work Please check whether the SIM card is out of date. 
The network is very weak Please move to a place with a strong signal to use the 

phone 
12.12 The phone can not recognise the storage card 

Possible reason Solution 
The storage card has been incorrectly 
inserted  

Please insert the storage card correctly 
according to instructions in the user manual. 

The storage card has been damaged Please replace the storage card. 
12.13 Lack of space 

Possible reason Solution 
History record saved in browser 
occupies too much storage capacity 

Please select［Internet→WAP settingss→Browser 
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settings→Clear cache］to release more capacity. 
MMS takes too much storage 
capacity 

Please delete unwanted MMS so as to release more 
space 

12.14 PC Camare can’t be used  
Possible reason Solution 

”PC Camera” menu doesn’t 
appear on the phone while 
connecting to the PC. 

1．Please make sure the USB interface of your PC is good. 
2．Please make sure you correctly use the connecting cable 
provided by the retailer. 

13. Safety Precaution 
13.1 Usage environment 
Please remember to obey relevant rules and regulations whenever use your phone. This will prevent bad effect from you and the environment. 
 Switch off your phone near explosive places, such as gas station, bunkers, chemical factories or blasting scene, and adhere to any safety signs and instructions there. Breaking any rules may cause explosion or injury. 
 Phone using in plane will interfere with the flight operation and bring dangers. Therefore,   please do switch off your phone before boarding, and make sure it is power off during the whole flight.  
Please keep the phone in its special braket while you’re driving. Please don’t put it on a seat or in places where it could fall off when the car encounts collision or break. In order to ensure safe driving and avoid 
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 road accidents, please don’t use the phone when driving. If you must use it, please use the phone’s hands-free asset or park at roadside before making or answering a call. 
 Please put the phone away from the high temperature environment, for explosion might be caused when the battery is of excess high temperature. 
13.2 Medical devices 
Please switch off your phone in areas near the electronic medical equipments that obviously requires switching the phone off (Such as heart pacemakers, hearing aids, etc). Most medical devices can shield the phone’s RF signal, but some can’t. If you have any doubts or need to find out more, please consult your 
doctor or medical device manufacturer. 
13.2.1 Pacemaker 
Pacemaker manufacturers advise the distance between your phone and heart pacemaker should be 6 inches (15.3 cm) at least, otherwise the phone could interfere with the pacemaker. 
The personnel who wears pacemaker should do the followings: 
 Should always keep a distance (at lease 6 inches) between the phone and pacemaker, when the phone is switched on. 
 Should not have the phone in a breast pocket 
 Should listen to the phone closer to the ear which is farther from the pacemaker. 

 Caution: 
Please switch off your phone while you feel there is interference, and consult the doctor timely. 

13.2.2 Hearing aids 
Mobile phone might bring some interference to some hearing aids. If so, please consult the hearing aids manufacturer. 
13.2.3 Emergency calls 
As the phone uses a radio signal, wireless and ground communication network and personal settings functions like other phones, it is impossible to ensure your phone can be connected successfully in any situation, so please don’t rely purely on your phone as the only means of notification in cases of emergency 
(such as medical first aid ). 
Make an emergency call  
If your phone is switched off, please turn on your phone and check whether the network signal is strong enough. 
(1) Input the local first aid number correctly (such as 120), different areas have different first aid numbers. 
(2) Please press the call key to call. 

 Caution: 
While making an emergency call, you should try best to provide all important information precisely. At this time, the phone may be the only communication tool, so don’t end the call without permission. 

13.3 Password access 
Your phone and SIM card can be protected by a password to prevent others using them illegally. 
13.3.1 Phone password 
This protects your phone from unauthorized users. You can set the preset password when you use it for the first time. After using it, please modify your phone password as soon as possible and keep it secret. 
13.3.2 PIN code 
This is personal identification code, which is used to protect the SIM card from unauthorized users. Generally, the PIN code and SIM card will be provided together. After activating the PIN code, you need to input correct password each time you switch the phone on to ensure noral usage. 

 Caution� 
If you input your PIN code incorrectly for three times in succession, the SIM card will be locked. You need to enter the PUK code to unlock it. (If you don’t have a PUK code, please contact your network operator or SIM card retailer for this information. Please don’t input any characters). 

13.3.3 PIN2 code 
This is the password for activating special functions of the SIM card. You need to input it while entering some functions (eg.Charge Unit, Fixed Dialing etc). Usually, the PIN2 code and the SIM card will be provided together. If you incorrectly input the PIN2 code for three times in succession, it will be locked and you 
will need to input PUK2 to unlock it. 
13.3.4 PUK code 
This is used to unlock the PIN code. Usually the PUK code and SIM card are provided together. If you don’t have it, please contact with your network operator or SIM card retailer. SIM Card won’t be used any more, if you incorrectly input the PUK code ten times in succession. In that case, please apply a new SIM 
card from your network operator. PUK code is unmodifiable. 
13.3.5 PUK2 code 
This is used to unlock the PIN2 code. Usually the PUK2 code and the SIM card are provided together. PUK2 can modify the locked PIN2 code. If you incorrectly input the PUK2 code for ten times in succession, you will not be able to access some functions. Please apply to your operator for a new card. The PUK2 
code is unmodifiable. If you lose it, please contact your service provider. 
13.4 Cautions for battery charging 
The phone provides power by using a lithium battery. The standby time and call time will be influenced by the system’s environment and phone settings. 
 Please use the approved battery and charger designated for this product. The company will take no responsibility for damage caused by unauthorized battery or charger. 
 The battery icon will start scrolling when the phone is charged in power-on-state. 

 Caution: 
1�If there is no battery left at all, then the battery icon will appear after 2-3 minutes of charging. The battery charging time depends on the status of the phone (whether switched on, making a call), usually, it will take about 2-5 hours.  
2. To make the new battery achieve its best capacity, please charge and discharge the phone for twice or three times. Please charge the new battery over 10 hours for the first several times. 

 Don’t use wet hands to touch the battery or charger while charging in order to avoid danger. 
 Try not to use the phone while charging. 
 The battery icon stops scrolling while the battery is full, and then you can disconnect the phone from the the charger adapter. 
13.5 Cautions for battery usage 
The battery usage depends on the network, phone setting and usage situation. Take Lithium ion battery of 1000 mill amperes capacity as an example, it allows calling time up to 4-5 hours, Dual-SIM standby time as 200-250 hours, and the single-SIM standby time as 250-300 hours.  
 Never use any damaged battery. 
 The phone will consume a little power if it is near network station. Therefore, the call and standby time depends greatly on the signal strength of honeycomb network and the parameters set by network operator. 
 The battery charging time lies on the remanent power, and the type of the battery and charger. When the operation time (talk time and standby time) is noticeably shorter than normal, it is time to replace with a new battery. 
 Only use batteries and charges authorized for this device, otherwise, explosion might be caused. Please disconnect the charger while unused. Do not leave the battery connected to a charger over one week, for overcharging may shorten the life length. 
 Do not connect the anode and cathode of a battery inversely. 
 Do not leave the battery in places with over-high or over-low temperature, otherwise, the battery capacity will be reduced and battery life will be shortened. Always try to keep the battery in room temperature.  
 Do not short-circuit the battery. This may damage the electronic core or internal protected circuit. If you keep the unused battery in the pocket or bags, metal objects (eg. coin, clip or pen, etc) inside might have the anode directly contacted with the cathode of the battery and caused accidental short circuit. 

Therefore, please carefully and separately store the battery. 
 Don’t burn your phone battery or treat it as common rubbish. Please adhere to the local environmental policy in order to avoid endangering life and causing environmental damage, and recycle your batteries in time. 
 If your phone, battery or other charging device is accidentally penetrated by water, you must not put it inside any calefaction equipment (such as drier, microwave oven etc.) to dry it. The phone or other products may go wrong, and may even cause the phone, battery or other charging device to burn, expand and 

explode. 
 Please deal with the discarded battery according to the relative introduction. 

The company will take no responsibility for any direct or indirect damage caused by user error. 
13.6 Cautions for spare parts usage 
 Please put all spare parts (such as SIM card, storage card, battery etc) out of reach of children, in case danger occurs. 
 Please do switch off the phone and unplug the phone and charger before you removing the battery from the phone. 
 As the phone’s spare parts are not waterproof, please keep all spare parts dry. 
 You should pull out the plug of any spare part correctly when you switch off the power, don’t drag the power line forcibly. 
If the phone, battery, and charger don’t operate normally, please contact closest quailified maintenance centres timely.  
13.7 Other safety information 
 If you don’t use your phone, it’s better to switch it off and remove the battery so as to save energy and avoid cellular radiation. 
 Please don’t have the volume over loud while using the phone, which might impair your hearing. 
 The unprofessional shouldn’t disassemble the terminal and battery of the phone. 
 It is recommended that you should try not to use the holster with magnet button, for the magnet may interfere with the phone signal, and hard iron button may crush the LCD screen. Plastic phone cover will lead to poor volatilization of vapor and have the internal components corrupted, moreover, it can have the 

phone shell oxidated and faded.  
 If you or your family has a medical record of dizziness or epilepsy, please consult with the doctor first, if you want to play phone games or use the flashlight (the flash doesn’t available in all phone models) 
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 Please don’t put the flashlight too close to the eyes of human beings or animals, as this could do harm to the eyes. 
 Should avoid the phone falling off from high places. 
 
 


